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Customising FrameMaker 11

Introduction
Since its beginnings it is possible to customise the user interface of FrameMaker:
 Menus can be switched from complete to quick. This is a
standard feature.
 Menus can be modified.
 Commands can be created and referenced in menus and
toolbars.
Until the arrival of the new user interface with FM-9 the process was described in an Adobe file, which was lastly issued
for FM-7. The text provided by this file is grosso modo still
valid for FM 11, but requires some added information.

Terminology
User-area

In Windows 7 this is
C:\Users\user\AppData\Roaming\Adobe\FrameMaker\11\

$HOME

The FM installation directory. In my case this is H:\Adobe\fm11.en\AdobeFrameMaker111).

Panel

A docked or undocked dialogue, which need not be closed to
work on the document. That is, it’s a nonmodal dialogue.

Panel group

A collection of Panels which can be handled as whole.

Pod

A misnomer for Panel, introduced in RoboHelp.

UI

User interface. The elements of user interaction: buttons,
menus, dialogues and windows. Also keyboard shortcuts
belong into this category.

Sources

Experiments and beta testing activities, personal communication with Matt Sullivan.






General procedure for
customisation

Help file for FM-9 and FM-10
Adobe blogs
Video: Getting started with the new FM-9 UI
Video: Workspace overview
Video: Customize and manage the Workspace

If the requirement can not be satisfied with entries in the Initialisation file maker.ini on page 28, consider setting up a custom workspace:
1 For special menu entries set up a custom menu file by
means of customui.cfg.
2 For special toolbars set up a custom toolbar.
This may require the creation of button images.
It does require a modification to fmtoolbar.xml and creation of a custom-toolbar.xml file..
3 Define the custom workspace. Copy an existing workspace
file (xxx.fws) to a custom named file and modify the references to menu and toolbar file.

1

The installation program does not allow to modify the last level. This is
due to new mechanism using a data base for installation/de-installation.
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UI properties
Initialisation file

2016-02-06

The maker.ini file got even more entries compared to older
FM-versions. Some of them are necessary to get back the
behaviour of previous FM-versions (for example
SymbolSortingBeforeAlphaNumeric).
Since FM-7.1 the file in $HOME is considered the master file and
only the file in the user-area is modified individually. These
files are now coded in UTF-8. Nevertheless special characters
can be defined in the traditional way:

D

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

FindSpaceBefore=On !%),.:;?]}\u00bb\u201d\u2019\u203a
;SmartQuotes \xd4\xd5\xd2\xd3 ) English curved quotes
SmartQuotes=‘’“”

The last line shown above uses the Unicode of the characters,
while the comment line uses the traditional notation.
Of course it is possible to establish in the user-area a complete copy of the $HOME file and then open FrameMaker. However, the entry ProductInterface is not present in the main
file. You get it with the answer to the start-up prompt.
At Initialisation file maker.ini on page 28 you find a complete
table with all entries present in the current file.

Structure of UI information
In the following diagram 2) the relationship of the UI elements
is displayed. Only the WYSIWYG view is elaborated.

Structured FrameMaker
FrameMaker
Author View

Structured View

XML (CodeView)

workspaces
Authoring.fws
project1.fws
project2.fws

2

WYSIWYG View

menus
menus.cfg
custom-menu.cfg

toolbars
fmtoolbar.xml
align_object.xml
graphics.xml
object_properties.xml
§…
custom-toolbar.xml
custom-char.xml
custom-display.xml
custom-extra.xml
…

Well, this is my interpretation of the Views – I may be completely wrong!
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Workspaces
A workspace is a saved set of frequently used panels/toolbars
in a desired arrangement for repeated use. It also offers flexibility of screen usage, by allowing a user to place panels in
numerous possible forms/arrangements: default, iconic, minimized, docked (left, right, bottom, top), floating, grouped.
The workspace remembers the dialogues that were open at
the previous session but also their positions, size, state etc.
FrameMaker ships with a set of standard Workspaces tailored
for different tasks. They can be modified an then saved with a
new name. FM-11 also provides an empty workspace to start
with.

}

}

Custom workspaces

Initial workspaces

Modifications to a workspace are temporary (until saved) and
can be reverted by Reset.
The last used workspace is noted in maker.ini. The workspace
is loaded with the first document to open. Hence this open
may be considered slow. No workspace is loaded with a book
file.
The workspace does not contain the document arrangement
(available with the drop down menu of
located to the
right of the menu area.
Workspaces are saved in the user-area. The current workspace
is in xxx.cfws, while the last save is in xxx.fws.
At the first use of workspaces they are taken from the FM
installation directory and copied to the user-area.
To design a new workspace for a specific task, open all the
required panels and save the Workspace using Save
Workspace. The names are case sensitive.

Workspace definition

Workspaces are defined in files xxx.cfws (current) and xxx.fws
(last saved).
The following is the definition found in Authoring.cfws (Long
lines are truncated here to display the structure):

<FrameUI version="1">
<data type="all" menuFile="menus.cfg" toolbarFile="fmtoolbar.xml"/>
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<fm-workspace>
<workspace version="1">
<dock anchor="left" content="palette toolbar" is-closed="false"/>
<dock anchor="right" content="palette toolbar" is-closed="false">
<tab-pane mode="expanded" preferred-iconic-length="0" layout-mode="auto-flow">
<tab-group active-palette="00060D1A" is-closed="false">
<palette id="00070800" is-closed="false" preferred-unconstrained-size="135
<palette id="001D07BA" is-closed="false" preferred-unconstrained-size="135
<palette id="00060D1A" is-closed="false" preferred-unconstrained-size="426
<palette id="00110A66" is-closed="false" preferred-unconstrained-size="135
</tab-group>
<tab-group active-palette="000807D0" is-closed="false">
<palette id="000807D0" is-closed="false" preferred-unconstrained-size="316
</tab-group>
</tab-pane>
</dock>
<dock anchor="top" content="multi-control-bar" is-closed="false">
<control-bar-pane >
<control-bar id="000707DA" origin="0 31" size="686 26" is-closed="false" …
</control-bar-pane>
</dock>
<dock anchor="bottom" content="palette" is-closed="false"/>
</workspace>
</fm-workspace>
</FrameUI>

Custom menu

260"…
260"…
387"…
260"…

180"…

If you want to refer to custom menu and toolbars, you will
change the references in line 2, for example to
<data type="all" menuFile="custom-menus.cfg"
toolbarFile="fmtoolbar.xml"/>

You will set up a corresponding menu file custom-menus.cfg.

Custom toolbar

If you want to refer to a custom toolbar, you will change the
references in line 2, for example to
<data type="all" menuFile="custom-menus.cfg"
toolbarFile="custom-toolbar.xml"/>

You will set up a corresponding list of toolbars in customtoolbar.xml. This list may then point to custom toolbars also.
If a toolbar contains a drop down list (which is flexible in
width) then the workspace must be tweaked after the toolbar
has been established and used.

Views
FM-11 introduced the concept of views as a means to group
workspaces. Hence there are more menus and toolbar groups
than before in FM-9 and FM-10.

D

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

2016-02-06

UI properties

This has also consequences for the customisation:
it is no more sufficient to have a
$HOME\fminit\configui\cstomui.cfg file. The contents of such
a file must also be appended to a menu file.

Pods
IMHO the terminology of FM has not yet settled. The term pod
should be eliminated - but is used since FM-9 and confuses
more than it clarifies.
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[Matt Sullivan]

Although one could make a case for establishing either Pod or
Panel as the proper nomenclature, when looking at the rest of
the Adobe product line, I believe that Panel is the better
choice.
Panels were initially referred to as Palettes, but as soon as
they became dockable, it seems that Adobe made an effort to
standardize the terminology to Panels.
Just as RoboHelp Environments have become RoboHelp Workspaces, I hope that (in both RH and FM) that the TCS crew
chooses to embrace the larger Adobe convention of Panel,
rather than Pod.

RH-specific

A pod is a work flow pane that you can float or dock anywhere in the application window. Pods provide quick access
to logically grouped features from one location. For example,
you can access various components of the project from the
Project Manager pod.

Other

Prior to FM-9 a dialogue was either modal (needed to be
closed) or non modal (could stay open like a palette). Some of
these have been replaced by dockable panels which can be
grouped into panel groups and minimised to icons.
Even in FM-11 there are still many of the old dialogues active.
Pods are also saved in the workspace.
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Toolbars

D

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

2016-02-06

The toolbars available for the UI are listed in an xml file which
is referenced in the workspace file (second line). The standard
name is fmtoolbar.xml. There may be more toolbar files, but
only those listed in this file are visible in the menu.
fmtoolbar.xml

modified with the custom toolbar

<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">
<TOOLBAR file="graphics.xml"/>
<SEPARATOR sep_id="0"/>
<TOOLBAR file="quick_access.xml"/>
<TOOLBAR file="structured.xml"/>
<SEPARATOR sep_id="1"/>
<TOOLBAR file="text_format.xml"/>
<TOOLBAR file="table_format.xml"/>
<TOOLBAR file="para_format.xml"/>
<SEPARATOR sep_id="2"/>
<TOOLBAR file="align_object.xml"/>
<TOOLBAR file="object_properties.xml"/>
<SEPARATOR sep_id="3"/>
<TOOLBAR file="trackchanges.xml"/>
</FMTOOLBARLIST>

<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">
<TOOLBAR file="graphics.xml"/>
<SEPARATOR sep_id="0"/>
<TOOLBAR file="quick_access.xml"/>
<TOOLBAR file="structured.xml"/>
<SEPARATOR sep_id="1"/>
<TOOLBAR file="text_format.xml"/>
<TOOLBAR file="table_format.xml"/>
<TOOLBAR file="para_format.xml"/>
<SEPARATOR sep_id="2"/>
<TOOLBAR file="align_object.xml"/>
<TOOLBAR file="object_properties.xml"/>
<SEPARATOR sep_id="3"/>
<TOOLBAR file="trackchanges.xml"/>
<SEPARATOR sep_id="4"/>
<TOOLBAR file="custom-example.xml"/>
</FMTOOLBARLIST>

The new UI defines toolbars in xml files which allow to define
the related image. The only toolbar which can not be customised is the graphics tool palette.

Example toolbar
The following is an example custom toolbar with all types 3) of
widgets.

Example toolbar file
<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">
<TOOLBAR id="tb_custom" name="Custom-example-tb" kbd-shortcut="\!Vzz"
orientation="horizontal">
<ACTION command="RepeatLastParaCommand" tooltip="Repeat last ¶ command [F4]">
<images normal="etb_para_repeat_R.png" rollover="etb_para_repeat_N.png"
dark_normal="etb_para_repeat_R.png" dark_rollover="etb_para_repeat_N.png"/>
</ACTION>
<TOGGLE name="Switch" tooltip="Switch between body and master pages">
<command on="ViewBodyPages" off="ViewMasterPages" />
<images normal="etb_body_R.png" rollover="etb_body_N.png"
dark_normal="etb_master_R.png" dark_rollover="etb_master_N.png"/>
</TOGGLE>
<DROPDOWN command="!RulerParaMenu" tooltip="Paragraph formats"/>
<FLYOUT command="!RulerAlignMenu" tooltip="Text alignment">
3

It seems that the TOGGLE tag does not work (or is not yet implemented)
– it should be the second button.
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<images normal="P_TextAlignLeft_Md_R.png" rollover="P_TextAlignLeft_Md_N.png"
dark_normal="P_TextAlignLeft_Md_R_D.png"
dark_rollover="P_TextAlignLeft_Md_N_D.png"/>
</FLYOUT>
</TOOLBAR>
</FMTOOLBARLIST>

Tags in toolbar files
The example file above demonstrates both tags and attributes.
Note:

First line of toolbar file
Comments

Be aware that in stings (e.g. defining the tool tip) no & must be
used. Hence not character entities are allowed. Use the word
and or the + sign instead.
<?xml version="1.0" encoding="UTF-8"?>

Comments are in the standard XML/HTML format:
<!-- One liner comment -->
<!-- Multiline comment
second and last line -->

FMTOOLBARLIST

This is the root tag in a toolbar file.
Syntax

Attributes

TOOLBAR

<FMTOOLBARLIST attributes />
TOOLBAR statement with details
</FMTOOLBARLIST>

version="1"
defines the version for which this toolbar file was
written. Value needs to be compatible with the
parser version.
This tag defines the toolbar and wraps the items on the toolbar.

Syntax

Attributes

<TOOLBAR attributes />
tool tags (ACTION, DROPDOWN, …)
</TOOLBAR>

file

the file name of the toolbar if the description is to
be picked from somewhere else, if this attribute is
defined no other attributes are parsed here.

id

unique identifier for the toolbar, for workspace
identification, FDK access and API notifications

name

The name of the toolbar as visible in menu.

orientation defines the default orientation of the toolbar
(default =horizontal)
horizontal: the default orientation is horizontal.
vertical-narrow: the default orientation is vertical
and the items are arranged in a single column.
vertical-wide: the default orientation is vertical
and the items are arranged in two columns.
dock

preferred/default dock (currently horizontal toolbars can be only docked at the top)
left: toolbar will be docked at the left anchor
right: toolbar will be docked at the left anchor
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top: toolbar will be docked at the top anchor
none: toolbar will be floating
kbd-shortcut key-sequence to activate the toolbar (default
=none)

Tool tags
ACTION
Syntax

2016-02-06
E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

The action tag defines the command assigned to an UI button.
<ACTION attributes />
<IMAGES ...>
</ACTION>

Attributes

TOGGLE

command

Identifier of an already defined FM Action required field.

name

The name of the action (default is the tag defined
for the command)

tooltip

The tool tip displayed on mouse hover (default is
the name of the action)

help

Help String for the action command (default= none)

image

An image-name for the action (default= None) 4).

A toggle tag is used to define two (logically alternating)
actions to be performed from a single widget
Syntax

<TOGGLE attributes1 />
<command attributes2 />
</TOGGLE>

Attributes1

Attributes2

name

the name of the TOGGLE (default= None)

tooltip

the tool-tip that is displayed on mouse hover
(default= name of the toggle)

help

Help String for the toggle command (default=
None)

image

an image-name for the toggle (default= None) 4).

on

Required identifier of an already defined FM (nontoggle type) Action.

off

Required identifier of an already defined FM (nontoggle type) Action.

</TOGGLE>

D

FLYOUT

This is used to define a popup menu.
Syntax

<FLYOUT attributes />

Attributes

4

command

Identifier of an already defined FM Menu - required
field"

name="

the name of the flyout (default= the tag defined for
the command)

tooltip

the tooltip that is displayed on mouse hover
(default= name of the flyout)

help

Help string for the flyout command (default= none)

image

an image-name for the flyout (default= none) 4).

This tag attribute may be replaced by images = list of images (see IMAGES on page 10)
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DROPDOWN

This is used to (generally) define a menu whose sub items is a
list of options that can be chosen from one at a time, for
example, fonts.
Syntax

Attributes

Note:

SEPARATOR

<DROPDOWN attributes />

command

Identifier of an already defined FM Menu - required
field"

tooltip

the tool tip that is displayed on mouse hover
(default= name of the drop-down)

help

Help String for the drop-down command (default=
none)

There is no width indication for this widget. The width is
assumed by the workspace mechanism. Hence it is not a good
idea to have more than one of these widgets in a toolbar.
This tag places a separator between two items
<SEPARATOR/>

Detail tag
IMAGES

This tag describes the images displayed on an ACTION, FLYOUT and TOGGLE, if not a single image shall be used.
Syntax

Attributes

<images attributes />

normal

the default image displayed when the UI is
bright (default= none)

rollover

the image displayed on mouse hover and
the UI is bright (default= normal image)

dark_normal

the default image displayed when the UI is
dark (default= normal image)

dark_rollover

the image displayed on mouse hover and
the UI is dark (default= dark_normal image)

Toolbar commands
All the menu items/commands that end up executing an
FCODE can be used here. Hence hypertext commands can not
be used.
See the section Commands on page 16.

Toolbar icons
Icons for toolbars and for the dialogues are located in
resource files:
fmcustom.dll
fmres.dll
owlres.dll

If images are needed, which are not in these resources, they
must be of type png (Portable Network Graphic) and be
located in the user-area.
The standard icon size is 18 × 18 pixel. At least two facets
must exist: a coloured one and a grey one. Two additional
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2016-02-06

images may exist (and are present for most icons in the
resource files:
Tag

Suffix

Example file

Appearance

normal
(in active)

_N

P_TextNormal_18x18_N.png

grey

rollover
(active)

_R

P_TextNormal_18x18_R.png

coloured

dark_normal
(hovered)

_N_D

P_TextNormal_18x18_R_D.png

grey

dark_rollover
(clicked)

_R_D

P_TextNormal_18x18_R_D.png

coloured

Hovered icons get a frame. At the click the icon gets a darker
background. Hence the icons should provide transparency.

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

Note:

Example

The file text_format.xml starts with the following lines:

<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">
<TOOLBAR id="tb_txt_fmt" name="Text Formatting" kbd-shortcut="\!Vte"
orientation="horizontal">
<ACTION command="StylePlain">
<images normal="P_TextNormal_18x18_N.png" rollover="P_TextNormal_18x18_R.png"
dark_normal="P_TextNormal_18x18_N_D.png"
dark_rollover="P_TextNormal_18x18_R_D.png"/>
</ACTION>
<ACTION command="StyleBold">
<images normal="P_TextBold_18x18_N.png" rollover="P_TextBold_18x18_R.png"
dark_normal="P_TextBold_18x18_N_D.png"
dark_rollover="P_TextBold_18x18_R_D.png"/>
</ACTION>

Contents of the UI files in
fminit

With the new UI two additional resource files were introduced: owlres.dll and owlres.res. These contain png images
which are not handled by (to me) known resource editors.
Also fmcustom.dll now contains png images, no more bmp bit
maps.

Resources Icons, pictures a

File

D

Exchanging the _N /_N_D and _R / _R_D assignments will
change the normal appearance to coloured. This makes the
icons more recognisable at a glance.

Dialogues

Other

fmcustom.dll

Completely replaced

Images for toolbar also
icons for the pods and
graphic toolbar

none

version info

fmdlg.dll

Many new items
(pods)

Rubi-bit maps [bmp]

classic dialogues, pods,
pod-lists

Icongroup (icons for the dialogues) version info; 500 (?)

fmres.dll

Some items no
more used

Button images for dialogues, palettes and pods
(16x16), [bmp]

none

Cursor group (32x32 cursors); Icongroup (icons in
pods etc.)

owlres.dll

new

Images for the new toolbars C-like definitions for appli[png]. 4 variants per image cation bar b, grafix bar, UI
preference dialogue etc.

Xstr (strings with all text in
xml notation); version info
(correct)

a. compared to FM-8
b. this comprises the functions to the right of the menu bar (UI visibility, Arrange documents, Screen mode)
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Integrating toolbar into workspace
You have referenced the toolbar in the main toolbar file
(fmtoolbar.xml, custom-toolbar.xml) which is mentioned in
the second line of your custom workspace.
The toolbar will appear in menu View > Toolbars. There you
activate it and it will initially float around.
The workspace mechanism has assumed a certain width of
the toolbar which can be adjusted with the lower resize handle:
Docking handle

Resize handle

As usual the toolbar is docked to the other toolbars with the
docking handle.
Then save your workspace.
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Configuration files define both commands and menus. These
files still have the format as in previous FM versions. That is,
they are named xxx.cfg and use the well-known MIF syntax
(not really xml).
The names of these configuration files are specified in the initialisation file for FrameMaker (see [Files] on page 34).
customui.cfg

If this file does not exist or does not have the name defined in
maker.ini (see [Files] on page 34) then no customisation takes
place.

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

Commands

D

The file fminit\configui\customui.cfg is a special configuration file called customisation file, because with this file commands and menus are customised.

The commands are defined in three files located in
$HOME\fminit\configui:
File

Contents

cmds.cfg

General commands, Escape sequences

mathcmds.cfg

Commands for the Equation Editor

wincmds.cfg

Platform dependent commands, definition of shortcuts

Menus

Until FM-10 menus were located in $HOME\fminit\maker. FM-11
introduced the concept of views which requires a multitude
of menus. See Menus on page 23.

Note:

While standard menus are in own files (separated from commands) the customisation file customui.cfg may contain both
commands and menus. Hence also a custom menu may contain
both kinds of definitions.

Configuration file
statements

A configuration file consists of a series of statements that
define menus, menu items, and the order of those items.
Commands are also defined in configuration files and may
contain definitions for details which may also be present in
menu files.

Properties of statements

comment example








Statements are case-sensitive.
Each statement is enclosed in angle brackets (< and >).
Statements must appear in a particular order.
A statements begins with a keyword defining its function.
A statement may span several lines.
Text outside angle brackets is treated as a comment. Don’t
include angle brackets in comments. Hence if you want to
out comment statements, you need to replace the < > symbols, for example, by { }.

[etb --- ETB addenda]
=======================================================
*** The [label] supports file navigation in EditPad
*** Remarks
- This file (customui.cfg) can not be UTF-8, but
Windows encoding using FrameRoman coding for
Label statements.
- Defaulit path ($HOME) is named here + fm-root+
(no blank after first +). This is exchanged by the
installation pgm with the real $HOME directory.
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Initialisation sequence

At start of FrameMaker, it first reads the standard menu and
command configuration files and then a customisation file 5).
The information in each file overrides the information in files
read previously. Hence the following actions must be in order:





Definition of the commands.
Modification of labels, shortcuts.
Definition of a menu item referring to a command.
Order of the menu item or sub menu within parent menu.

Statements in configuration files
Purpose

Statement, statement detail

Define a command

Command on page 17

Define a command for a menu item that ShiftCommand on page 17
is chosen while the Shift key is held down
Define a new label for a command or
menu item

Modify on page 18

Define the function to be called when a
command is chosen

Definition on page 19

Define a label for a menu or command
that is visible in the user interface

Label on page 19

Define a context-sensitive label for a
menu or menu item.

ReservedLabel on page 19

Define a keyboard shortcut for a command

KeySequence on page 20

Define a label for the shortcut which ap- KeySequenceLabel on page 21
pears next to the command name on the
menu
Define whether a command is a general
command, a FrameMath command (for
the Equation Editor), or both

Mode on page 22

Define an Asian typography command

AsianFonts on page 22

Define a new menu

Menu on page 25

Define a new reserved menu

Reserved menu on page 25

Add a menu item to a menu

Add on page 27

Define a particular place for a menu item Order on page 27
on a menu.
Remove a menu or menu item

5

Remove on page 17

This process is called Localisation in the progress indication of the start.
This is due to the fact that the menu files are different for each UI language. In FM the UI language is defined at installation - it can not be
changed afterwards.
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Special commands
Multi-code commands

For multi-code commands only two of the three UI elements
may be defined: button, menu item, shortcut. If all three are
defined, then only the first code will be executed.6)
Hence for the following no menu item has been defined:

2016-02-06

<Command EditingDisplay
<ReservedLabel Document &Editing Display>
<KeySequence \!qqe >
<KeySeqLabel Esc q q e>
<Definition \x3F1 \x3F2 >
<Mode All>>

<Command ETBGoToMasterPage
<Definition \x343 \x345 >
<Label Go to a Specific Master Page... >>
<Add ETBGoToMasterPage
<Menu ViewMenu>>
<Order ViewMenu.ETBGoToMasterPage
<Before
ViewMenu.ViewMasterPages>>

Hypertext commands

It is not possible to define shortcuts for hypertext commands.
For example, the shortcut defined here is not executed:

<Command ETBspecial0 <Label Using FrameMaker 11>
<Hypertext message openfile H:/Adobe/framemaker.11en/…/etb-fm11-help.pdf>>
<Modify ETBspecial0 <KeySequence \!qqq><KeySeqLabel Escape q q q>>

Hypertext commands can only be used in menus, not for toolbars.

Debugging customisation files
If you’re writing a lengthy menu customisation file, consider
writing and testing the customisations a few at a time. This
will make it much easier to locate problems in the statements
you write. As you create the file, you can save the file and
then read it into FrameMaker to test your statements.
To display error messages when you load a menu customisation file, set the ShowErrors setting in maker.ini to On. You
can also turn On the keyboard shortcut alerts
(ConfigWarnKbdOverride, ConfigWarnKbdOverride) to see error
messages in the console window. If you find errors, you can
fix them immediately and continue writing.

D

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

And for the following only a menu item (and no shortcut or
button) has been defined:

When you read the same menu customisation file again 7),
you’ll see error messages about redefining a command
(because the same statements are being read again). Don’t
worry about these messages. Use comments throughout the
menu customisation file to document your work. Others may
need to edit the file later.

6
7

This is a problem since FM-9 and is most likely is a consequence of the
new user interface.
I’m not certain whether this method with View > Menus > Modify…
works reliably in FM-11. We do have now at least two modification files…
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Commands
There are three command files in $HOME\fminit\configui:
cmds.cfg
mathcmds.cfg
wincmds.cfg

For customisation it is not necessary to modify any of the
standard command files. All customisation of commands is
done in customui.cfg. and one or more menu files.
Note:

A complete list of commands can be found on my website.

Command examples
Explanation of the keywords see Command statements on
page 17.
Normal command

Command with restricted
context

Modify the shortcut

<Command NewDocument
<Label Document...>
<KeySequence \!fn>
<Definition \x300>
<Mode All>>

Name of the command
What you see in the menu
Shortcut (ESC sequence)
FCODE, the command definition
Valid contexts for this command

<Command SelectAll
<ReservedLabel Flow Select All in Flow>
<ReservedLabel Frame Select All in Frame>
<ReservedLabel Page Select All on Page>
<KeySequence \!ea>
<Definition \x327>
<Mode All>>
<Modify SelectAll
<KeySequence ^a> >

… and indicate it in the menu

<Modify SelectAll
<KeySequenceLabel CTRL+A> >

Combine these two
modifications

<Modify SelectAll
<KeySequence ^a>
<KeySequenceLabel CTRL+A >>
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Command statements
Command

The command statement is the wrapper definition for the
command:
Syntax

<Command cmd-name <detail1> <detail2> <detailn>>

Details may be added to a command also by the Modify statement on page 18.

Details

A unique name of the command. This serves as a reference
between the various statement types.
For the detail specifications see Command details on page 19.

Examples

See also the examples given in the introduction to Commands.
<Command PrintingDisplay
<ReservedLabel Document &Printing Display>
<KeySequence \!qqp > <KeySeqLabel Esc q q p>
<Definition \x4F1 \x4F2 \x4F3 \x3F8>
<Mode All>>

Note:

Custom command

This command is defined by 4 function codes which imposes
some problems. See the remark at Multi-code commands on
page 15.
A custom command must not use an already existing name.
Hence it is good practice to prefix the name with an indicator,
for example:
<Command ETBVertToolBar …>
<Command _MTCharSet …>

ShiftCommand

Enhanced Toolbar
Microtype’s Customisation

This statement defines a command for a menu item that is
chosen while the Shift key is held down. Hence this statement
normally appears in a menu file (not a command file).
Syntax

<ShiftCommand cmd-unshifted cmd-shifted>>

Cmd-unshifted
Cmd-shifted
Examples

This is the identifier of the command as it normally appears.
This is the identifier of the command you want to appear
when you hold down the Shift key.
<ShiftCommand Save SaveAll>
<ShiftCommand FindNext FindPrevious>

Note:

D
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Cmd-name

8) Commands

defined by ShiftCommand can not be placed in context menus. The insertion of the command (by Add) does not
create an error, although the command is not inserted. A further Order command however will not find the (not) inserted
command and create an error.
Example creating the error

<ShiftCommand GraphicsObjProps GraphicsPickObjProps>
...
<Add GraphicsPickObjProps <Menu !GraphicsContextMenu>>
<Order !GraphicsContextMenu.GraphicsPickObjProps <After
!GraphicsContextMenu.GraphicsObjProps>>

Remove

You can not remove commands. Only the menu entry is
removed.
<Remove cmd-name <Menu menu-id>>

Examples

<Remove GraphicsReshape <Menu GraphicsMenu>>
<Remove GraphicsReshape <Menu QuickGraphicsMenu>>
8

I have reported this as bug # 3494702 as of 2013-02-01.
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Modify statement
Modify

The Modify statement is used to change details of a command. This command must already be defined. The change
may affect:
 the label(s)
 the key sequence aka shortcut(s)
 the key sequence label(s)
Syntax

<Modify cmd-name <new-detail1> … <new-detailn>>
<Modify cmd-name [context-id] <new detail>>

Cmd name

This is the name (ID) of the command whose properties shall
be modified

Details

In the Modify statement the same details can be defined as in
a Command statement. See Command details on page 19.
Modifications are cumulative for key sequences (shortcuts)9).
The other details are overwritten by the newest one.

Examples

<Modify NewDocument
<KeySeqLabel Ctrl+N>>
<Modify TerminateMaker
<Label E&xit>>

character

Renaming a context sensitive
command

Define Label with access

To rename the label of a context sensitive command, both the
command-name and the context-identifier (here: Frame) must
be given:
<Modify SelectAll <ReservedLabel Frame Select Everything in
Frame>>

Various labels for same
command

To get different label for a command in only one place, define
a new command that duplicates the function of the old one
(using the same key sequence, definition, and mode), but use
a different label. Then put the new command on the menu in
place of the old one.

9

If a customisation file contains shortcut definitions for commands that
already have shortcuts defined for them, warning messages may be written to he console log file. This happens with ConfigWarnKbdRedundant = On
in maker.ini (see [Preferences] on page 30).
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Command details
Definition

This defines the function of the command.
Syntax
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Fcode

Label

<Definition \x300>
<Definition \x302>
<Definition \x3F1 \x3F2 >

Create new document
Command Help
Borders and Text symbols On

The label defines the entry in a menu. It also provides a
default for tool tips on buttons using this command.

Access key definition

}

}
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The function code is the connection between the command
and the routine in the application which performs the function. A command may issue several functions, although most
commands have only one Fcode associated.
The Fcode is noted as \xnnn with nnn being a hexadecimal
number. You can find relevant Fcodes in the FDK 10) documentation or in the command files or in special lists derived from
these files.

Examples

Label

Syntax
Label string

Example

KeySequenceLabel

<Label label-string defining the menu entry>

If an ampersand character (&) is needed in the label-string,
it must be doubled. This is due to the fact that the & precedes
an access character11). This will be underlined in the menu.
<Label P&rint Setup…>

This will display in a menu as Print Setup…

ReservedLabel
D

<Definition Fcode1 [Fcode2 … Fcoden]>

Some commands have a different label, and a different effect,
depending on the state – where the insertion point is, what is
selected, and so on. In these cases, the command gets a context-id defining the condition in which it can be chosen. Each
of the conditions has a ReservedLabel statement.
Syntax
Context-id

<ReservedLabel context-id label-string>

The following context-ids are used in commands:
Context-id

Condition

Body

Body pages are displayed

Book

Book window is active

10 FDK = FrameMaker Developer Kit
11 The adobe document calls this a mnemonic shortcut.. The access character
must be carefully chosen to avoid duplicates with a menu.
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Label string
Example

Context-id

Condition

Ditamap

Ditamap is active

Document

Document is active

Flow

Flow is selected

Frame

Frame is selected

Generic

Set up any generated file

History

History window

Long, Long2

Complete (Long) menus is active

LongMultiple

Multiple book components are selected

LongSingle

Single book component is selected

MacEdition…

Probably depreciated, since Macintosh is no more supported.

Master

Master pages are displayed

NoDelete

This page can not be deleted (e.g. Left/Right master page)

NoName

This page has no name (not yet saved)

NotRegistered

Product not yet registered

Other

Other than body pages are displayed

Page

???

Redo

Undo command list

Reference

Reference pages are displayed

Registered

Product is registered

Repeat

Repeat xxx

Scratch

Probably a left-over from program development

Search

???

Short, Short2

Short (Quick) menus is active

Straddle

Selected cells are not straddled

Table

Table is selected

TextInset

Text inset is active

TOC, LOF, …

Set up the respective generated file TOC, LOF, LOT, LOP,
LOE, APL, AEL, LOM, AML, LOR, IX, AIX, SIX, IOM, IOR)

ToTable

Selection is paragraph(s)

ToText

Selection is a table

Undo

Redo command list

Unstraddle

Selected cells are straddled

The same rules as with the Label detail apply.
<Command SelectAll
<ReservedLabel Flow Select All in Flow>
<ReservedLabel Frame Select All in Frame>
<ReservedLabel Page Select All on Page>
... >>

The SelectAll command acts as a place holder on the menu
for the group of commands: Flow, Frame, and Page, all of which
have the same command definition.

KeySequence

The key sequence defines a shortcut for the command.
Syntax

<KeySequence sequence>
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Sequence

This defines the sequence of keystrokes. Two cases must be
distinguished: Keys to be pressed together (key group) and
keys to be pressed one after the other (key sequence).
If you need the symbols literally in a sequence, the symbol
must be preceded by a solidus (/). For example to use the + in
a key sequence literally, you provide /+

2016-02-06

Key group

A base key is pressed together with modifier keys. These modifier keys are defined
with special symbols:
Escape key: \!
Shift key: +
Control key: ^
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Alt key 12): ~
A key group should not use more than two
modifier keys, because humans have only
two hands …
Windows key: /Win 13)
Key Sequence

These sequences mostly start with the
Escape key. Non-alphanumeric keys need a
special notation:
Escape key: \!
Application key 14): /Apps
Function keys: /F1 … /F12

Note:

Examples

Defining a key group must consider existing key groups. If a
key group ESC,q,q is already defined, ESC,q can no more be
defied, because the input process waits for the next q. If You
then enter just any other character (e.g. z), nothing will happen.
Existing key groups mostly mimic the menu entries they support. Hence they depend on the UI language. For example the
sequence for Repeat last character modification is Esc,c,c in
the English, and Esc,z,w in the German FrameMaker.
<KeySequence +^b >Shift+Control+B (one key stroke)
<KeySequence \!/+c >Escape, Plus, c (three distinct key

strokes)

D

Shortcuts on the Equations
palette

KeySequenceLabel

The shortcuts that appear on the Equations palette can not be
customised. This palette is actually a special view-only document containing hypertext commands.
The key sequence label is added to the right side of a menu
entry.

Syntax

<KeySeqLabel descriptive-string>

12 On European keyboards the right Alt key is engraved AltGr (Alternate
Graphic). Pressing this key together with another key types the special
graphic engraved at lower right of the symbol key. AltGr is equivalent
to Alt+Ctrl .
13 Windows uses several key sequences with this key. See Wikipedia. Key sequences with the Win key are not possible, since it opens the Start menu.
14 The Application Key is available only on Windows Keyboards right to the
space bar. Its standard function is to open the context menu.
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Descriptive string

Examples

Note:

Mode

The descriptive string echoes the key sequence(s) of the command. You distinguish the two cases of key sequences by different notation:
Key group

Key names concatenated with a + sign.

Key sequence

A list of key-names

<KeySeqLabel
<KeySeqLabel
<KeySeqLabel
<KeySeqLabel

CTRL+A>
Escape, q, q, e>
Esc q q p>
ALT+Shift+F9>

Key
Key
Key
Key

group
sequence
sequence
group

If a command does not have a KeySeqLabel detail, the command will be displayed on the menu with no shortcut. This
does not mean the shortcut does not exist; it just means the
shortcut is not displayed on the menu.
The Mode defines the validity of a command for a particular
environment. Example

Syntax
Mode

<Mode mode >

Defined modes (used in commands) are:
Mode

Example

AsianFonts

All

The default

Math

During Equation editor

NonMath

Anything but Math

<Mode NonMath >

To define a command that appears in menus only if your system supports typing Asian text in documents and dialogue
boxes, use this detail:
Syntax
Note:

<AsianFonts Yes>

AsianFonts No has the same effect as omitting the statement.
In this case the command applies to all configurations.
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Menus
customui.cfg

For FM versions prior to FM-11 all customisation was established in the file fminit\configui\customui.cfg.
The possibilities in this file are explained extensively in the
Adobe document Customisation of Frame Products.
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This file is still required if the modifications shall be visible
in the menus before any document is open. That is at the time
of the splash screen.
However, the contents of this file must also be appended to
the relevant menu file. It is good practice to copy a menu file
to a new name, e.g. custom-menu.cfg and then append the contents of customui.cfg to it.
Since FM-11 the contents of menus depend on a view. Hence
there are several menu files:

D
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$HOME\fminit\WorkSpaces
AuthorView
menus
menus.cfg
toolbars
fmtoolbar.xml
…
workspace.cws
CodeView
menus
menus.cfg
toolbars
fmtoolbar.xml
…
toolbars
fmtoolbar.xml
…
workspace.cws
Structured
menus
menus.cfg
menus_review.cfg
menus_structured_authoring.cfg
toolbars
fmtoolbar.xml
…
workspace.cws
Unstructured
menus
menus.cfg
menus_review.cfg
toolbars
fmtoolbar.xml
…
workspace.cws

Note:

Although there are for menus with the same name menus.cfg
these files are not identical in content.
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Customising menus
Using menu
customisations

If you create a menu customisation file, you have several
choices for reading the information into FrameMaker.
FrameMaker can read the file in automatically when it starts
up, or you can load it yourself once the product is running.
The customisations take effect as soon as the file is read. Any
errors in the customisation file are reported in the
FrameMaker console window. Each error message contains the
line number in the file and a description of the problem. Even
if an error is found, the rest of the file will be read.

Customisation

To create your custom menu, take the appropriate standard
menu and copy it to a new file. Name this file with a prefix of
your customisation project. For example custom-menus.cfg.
You develop the customisation in a file customui.cfg which is
located in $HOME\fminit\configui\. As long as you have not a
customised menu assigned to a workspace, the menu customisation is only visible during at the display of the splash
screen (before you have opened a document or book).
To be available for open documents or books the contents of
customui.cfg must also be appended to a menu file, which is
referenced in the workspace (see Custom menu on page 5).
To available also with no document or book open, workspace
$HOME\fminit\WorkSpaces\UnStructured\none.cws must point
to the modified menu:

<data type="all" menuFile="custom-menus.cfg" toolbarFile="fmtoolbar.xml"/>

Example customisation

Lets assume that you want to modify the Help menu: Instead
of the items Samples… and Clip Art… which just open the
Samples or Clipart folders with File Explorer, you want to
open a special file with hyper jumps to the sample files and
the clip art files.

Menu entry

Defintions in the menu file a

Help

<ReservedMenu !HelpMenu<Label Help>>

Help Topics...

<Add Help<Menu !HelpMenu>>

Samples...

<Add SamplesCmd<Menu !HelpMenu>>

Clip Art...

<Add ClipArtCmd<Menu !HelpMenu>>
<Add Separator1<Menu !HelpMenu>>

Support...

<Add AdobeOnlineSupport<Menu !HelpMenu>>

Complete/Update Adobe ID Profile ...

<Add AMTRegistration<Menu !HelpMenu>>

Deactivate...

<Add AMTDeactivate<Menu !HelpMenu>>

Updates...

<Add AMTUpdates<Menu !HelpMenu>>
<Add Separator2<Menu !HelpMenu>>

FrameMaker Product Improvement
Program...

<Add FMPIP<Menu !HelpMenu>>

FrameMaker Online...

<Add AdobeOnline<Menu !HelpMenu>>

About FrameMaker...

<Add AboutFrameProduct<Menu !HelpMenu>>
<Modify AboutFrameProduct
<Label About FrameMaker...> >

a. Items highlighted are referenced in Example customui.cfg on page 25.
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The task of customisation hence is:
 Define a command which performs the desired action.
 Delete the second and third menu entry and replace it by
one new entry.

Example customui.cfg

In the following we set line numbers at the beginning for ease
of reference (these are not part of the file contents).
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01 <Command ETBspecial
<Label Templates, Samples && Clip Art>
02
<Hypertext openlink
+fm-root+/fminit/configui/etb-samples.fm>>
03 *** Replace Samples & Clip Art
04 <Add ETBspecial<Menu !HelpMenu>>
05 <Order !HelpMenu.ETBspecial <After !HelpMenu.Help>>
06 <Remove ClipArtCmd <Menu !HelpMenu>>
07 <Remove SamplesCmd <Menu !HelpMenu>>

Explanation

01, 02

The command ETBSpecial is defined. The hypertext
command uses an absolute path 15). The variable
part +fm-root+ depends on your installation. The
referenced file etb-samples.fm is read only and
contains hyper-links to other files in the same
directory.

03

This is just a comment (outside any <...> construct.

04

The command is integrated into the main menu.

05

This new item is now placed. Without this statement it would appear at the end of the main menu
(after About FrameMaker...).

06, 07

The now superfluous entries are removed.

Menu statements
Menu

A new menu or sub menu is defined with this statement:
Syntax
Examples

Reserved menu

<Menu menu-name <Label menu-label>>
<Add ETBspecial <Menu !HelpMenu>>
<Add ETBVertTb <Menu ETBspecial>>
<Add ETB

D

Many of the menus defined in the standard menu files for
FrameMaker are reserved menus. FrameMaker has intrinsic
knowledge about reserved menus; it can refer to these menus
directly by name.
By convention, the names of reserved menus in the Frame
menu configuration file all begin with an exclamation point
(!). See Permanent menus on page 26 and
Syntax
Menu-name

<ReservedMenu !menu-name <Label menu-label>>

FrameMaker relies on Permanent menus and also on Context
menus. Both are defined with the ReservedMenu statement in
15 Hyper-links with relative paths always point to files in the same directory
as the parent file. Hence a link to fminit/configui/etb-samples.fm
assumes the file in the directory of the currently open document with
subdirectory fminit etc.
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the standard menu files. Custom menus must not use names
of these reserved menus. It is a good idea to prefix custom
menu names by a project abbreviation. For example, ETBmenu
or !_MTmenu.
Menu-label

Permanent menus

Context menus

The Label detail is the same as for commands, because the
command is represented in the menu item.
FrameMaker relies on the following menus existing. They are
all menu bars or are associated with formatting16). You cannot remove these menus from a menu configuration file.
FrameMaker will not work properly without them.
Menu ID

Description

!BookMainMenu

Menu bar for complete menus (book window active)

!CustomMakerMainMenu

Menu bar for custom menus (document window active)

MakerMainMenu

Menu bar for complete menus (document window active)

!QuickBookMainMenu

Menu bar for quick menus (book window active)

!QuickMakerMainMenu

Menu bar for quick menus (document window active)

!RulerAlignMenu

Alignment pop-up menu in the formatting bar

!RulerControlMenu

Formatting bar

!RulerParaMenu

Paragraph Formats pop-up menu in the formatting bar

!RulerSpaceMenu

Spacing pop-up menu in the formatting bar

!ViewerPopup

View-only document window pop-up menu

!ViewOnlyMainMenu

Menu bar for view-only document

The default context menu for a particular selection does not
contain every possible command you can do to the selection.
If a menu item is not applicable to the selection and the current state of the product, it will be dimmed.
Context menus can not contain shifted commands. See ShiftCommand on page 17).
Context menus can also be displayed by pressing Shift+F10.
In this case, the appearing menu depends on whether there
exists a selected object, an insertion point, or neither.
This context menu id

Identifies the context menu for:

!AnchoredFrameContextMenu

an anchored frame

!BookContextMenu

a book window

!DocumentContextMenu

the document as a whole (no active insertion
point and nothing selected)

!EmbeddedObjectContextMenu

an OLE object

!GraphicsContextMenu

all graphic objects except an anchored frame

!MathContextMenu

an equation

!MultiGraphicsContextMenu

any grouped graphic object

!QuickBookContextMenu

a book window when Quick Menus is the current
menu set up

!StructureContextMenu

the Structure View in FrameMaker+SGML

!StructuredTextContextMenu

text in a structured text flow in
FrameMaker+SGML

!TableContextMenu

a table

!TableTextContextMenu

text in a table

16 These menus with names starting with !Ruler may be obsolete in FM-11.
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Add

Identifies the context menu for:

!TextContextMenu

text

!TextLineContextMenu

text line selected as text

!TextLineGraphicContextMenu

text lines selected as graphic objects

!ViewerPopup

a View-only document window

!ViewOnlyBookContextMenu

a View-only book window

This statement adds an item to a menu at the end of the
already existing entries. Hence normally a corresponding
Order statement must exist in a customisation file.
Syntax
command
menu-name

<Add command <Menu menu-name>>
<Add Separtorn <Menu menu-name>>

This identifies an already defined command.
The name of the menu to which the command shall be added.

Separator

Within a menu the separators must be numbered to get
unique names for an Order statement.

Examples

<Add
<Add
<Add
<Add

Order

Open
ETBspecial
ETBVertToolBar
Separator5

<Menu
<Menu
<Menu
<Menu

FileMenu>>
!HelpMenu>>
ETBmenu>>
ETBmenu>>

This statement defines where a menu entry shall be placed in
the menu.
Syntax

menu
new-item
ref-item
Examples

<Order
<Order
<Order
<Order

menu.new-item
menu.new-item
menu.new-item
menu.new-item

<First menu>>
<Last menu>>
<Before menu.ref-item>>
<After menu.ref-item>>

The menu we are talking about. It has been defined with a
Menu statement.
The item to be ordered. It has been defined in the menu.
The reference item in menu relative to which the new item is
inserted.
<Order !TextLineContextMenu.SpecialCharsContext
<Before !TextLineContextMenu.Undo>>
<Order !TextLineContextMenu.Separator1
<Before !TextLineContextMenu.Undo>>
<Order ViewMenu.ViewGraphicsOn
<Before ViewMenu.Separator3>>

D
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Initialisation file maker.ini
Note:

Much information is taken from the Adobe File “Customizing
Frame Products” as issued at last for FM-7. However a current
ini file is used as reference.
The maker.ini file is a standard Windows initialisation file
which is divided into sections. Section names are enclosed in
brackets. The equal sign may be surrounded by spaces:
[Frame]
ProductInterface=FrameMaker
; Comment lines start with a semicolon.

Note:

When opening an initialisation file in FrameMaker, assure to
open it as Text. When you’re finished editing the file, use the
Save As command to save it as Text Only.

Table of entries
The initialisation file contains settings such as default
options for the Preferences dialogue box, values for the
Zoom pop-up menu, and the names of dashed lines. It also
gives the locations of directories and files that FrameMaker
needs to find as you work.
Sections

General settings ...............................................
[Frame] .......................................................
[Preferences] ...............................................
[Directories] ................................................
[Files] .........................................................
Language services ............................................
[SpellingProvider Preferences] ......................
[HyphenationProvider Preferences] ...............
[ThesaurusProvider Preferences] ..................
[Spelling] ....................................................
Content management .......................................
[CMSFavourites] ..........................................
[DctmPreferences] .......................................
[SpPreferences] ...........................................
Miscellaneous ..................................................
[DialogLayout] .............................................
[ViewClients[ ...............................................
[XSLTProcessors] .........................................
[APIClients] .................................................
[DashPatterns] ............................................
[Thermometers] ..........................................
[DocCompare] .............................................
Structure view ..................................................
[StructureView] ...........................................
[BannerText] ...............................................
Fonts ..............................................................
[Fonts] ........................................................
[FontAngleAliases] ......................................
[FontWeightAliases] .....................................
[WindowsToFrame FontAliases] ....................
[UnknownToKnown FontMap] .......................
Filters .............................................................
[Filters] .......................................................
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30
30
30
34
34
36
36
36
36
36
37
37
37
37
37
37
37
37
38
38
38
38
39
39
40
40
40
41
41
41
42
43
43

Initialisation file maker.ini

User profile versions of
maker.ini
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Windows NT4

a

FrameMaker always stores a copy of the initialisation file,
maker.ini in $HOME. To save settings for individual user profiles FrameMaker also stores a user’s copy of maker.ini in a
User Profile, the location of which (user-area) depends on the
Windows version:

C:\WinNT\Profiles\LogonName\Application Data\Adobe\FrameMaker\version\11

Windows 2000, XP

C:\Documents and Settings\LogonNname\Application Data\Adobe\FrameMaker\version\11

Windows Vista, W7

C:\Users\LogonName\AppData\Roaming\Adobe\FrameMaker\version\11

a. I assume that FM-11 does not run smoothly on NT.

When FrameMaker starts up it uses the settings in the installation version of maker.ini plus the settings in the user’s personal version of maker.ini as follows:
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 FrameMaker reads all the entries in the installation version
of maker.ini
 For single settings such as view options or recently visited
files, if there is an entry in the user’s personal version of
maker.ini FrameMaker uses it to override the entry from
the installation version
 For accumulated settings such as installed plug-ins (API clients), FrameMaker adds the user’s personal entries to the
entries found in the installation version of maker.ini
To make a change to maker.ini that affects all users who will
log onto a particular system, modify the settings in the installation version of maker.ini. For example, you might want to
register an FDK plug-in via this version of maker.ini to ensure
every user has access to the plug in. To restrict changes to a
specific user you would modify that user’s personal version
of maker.ini.

Special characters

While editing a FrameMaker initialisation file, you may need
to type a character not immediately accessible on a standard
keyboard (that is, whose hexadecimal (hex) code is greater
than \x7f). For example, you may need to enter special quotation marks (see [Spelling] on page 36). You can do this by typing a backslash followed by the character’s hex code. For
example, to include an acute-accented e (é) in the name of a
custom dashed line, you use the hex code for this character
(\x8e). Your entry in might look like this:

D

8=caf\x8, 12, 6, 6, 6

The hex codes are listed in the FrameMaker Character Sets
online manual. Some special characters might not display
properly in dialogue boxes.

System information
about FrameMaker

The Windows system registry contains information that Windows needs to launch FrameMaker. The system registry
includes low-level characteristics that determine cursor blink
rate, desktop pattern, and filename extensions associated
with the FrameMaker. The location of the FrameMaker application and its initialisation file are also stored here.

Location of FrameMaker

You should be aware of two entries placed in the system registry when you install FrameMaker. One specifies the install
path:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\AppPaths\FRAME.EXE
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(default = actual path to frame.exe)
The other entry specifies the initialisation file for
FrameMaker:
HKEY_LOCAL_MACHINE\SOFTWARE\Adobe\FrameMaker\7.0\IniFile

(default = maker.ini)
Note:

Since FM-9 the installation folder must not be moved, because
there is no simple installation log, but a complete data base. It
is nearly impossible to change the settings therein reliably.

Associating file name
extensions with FrameMaker

There are three file name extensions associated with
FrameMaker in the system registry. These extensions are .fm,
.book, and .mif.

Entries in maker.ini

The tables hereafter list the sections more or less in their
order as in the file. The entries in the sections, however, are
listed in alphabetic order for better reference in print.
Over time entries appeared and disappeared in maker.ini.
This table lists only entries present in FM-11. You may find a
complete list on this website.

General settings
[Frame]
Variable

Sample values

Remarks

Language

UKEnglish

UI language, default ¶ language, default spelling dictionary; depends on installation

ProductInterface

FrameMaker / Structured
FrameMaker

Start up mode, kept in user-area only.

Variable

Default / Option

Remarks

AllowNewFileURL

On/Off

Provides URL support for files referenced in the an xml
file (you can specify the file paths in additional formats)

AlwaysDownloadURL

Off / On

See Note 18 on page 46.

API

On / Off

ON: Enabling FDK client programs. See [APIClients] on
page 38
OFF: These programs are not started

ApplyAsCondition

On / Off

ON: Applying a condition tag to content filtered with a
Filter By Attribute is possible.
OFF: Disable this option

ApplyCondTillElementBoundaries

Off / On

ON: Apply a conditional tag to the whole element, even
if only a part of the element is selected (only applicable
to structured documents)

AskExit

On / Off

Prompt for quitting FM

AutoCollapseIconicPanels

Off / On

Preferences > Interface

AutoMnemoniseMenus

On / Off

Determines if mnemonic command shortcuts are shown
on menus (ALT + v, b for menu View, Borders)

AutoSave

On 5/ Off 5

Period of auto saving [min] (how often FrameMaker creates a backup file for the active file, whether or not you
have saved it).=> Preferences > General

AutoShowHiddenPanels

On / Off

Preferences > Interface

AutoSpellCheckCorrectionListSize

5

Number of correction proposals

[Preferences]
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Variable

Default / Option

Remarks

BackupOnSave

On / Off

Backup file is automatically created when saving a file
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Character Map

Files > Utilities > Character Map

- CharPalette_Key
HexInput_Key

Win+I
Win+H

Key Combinations can be a combination of
Ctrl+Shift+Alt+Win+some key code

-

RememberPage

0

-

RememberFont

Courier

-

Encoding

2

0: UTF-8; 1: UTF-16; 2: UTF-32

-

Width

420

Width of palette in pixel

-

ClipBoardForCharPalette

Off / On

-

ClipBoardForHexInput

On / Off

CheckoutOnOpen

On / Off

Checkout from CMS on open of document

ClearHistoryOnSave

Off / On

Multiple undo was introduced

ClipboardFormatsPriorities

FILE, TEXT, OLE 2, EMF, META, DIB, BMP, MIF, RTF,
TEXT, UNICODE TEXT

Inserting items from clipboard taken from other applications
Edit > Paste Special overrides these settings. See
Note 1 on page 44

ConfigWarnKbdRedundant

Off / On

ConfigWarnKbdOverride

Off / On

Issue warnings when interpreting the customisation files
(*.cfg)

ConvertGraphicsToEPS

Off / On

PDF set up

CreateAllNamedDestinations

Off / On

PDF set up

CrossPlatformFileNaming

Windows 9x/2000/NT
Macintosh
UNIX

Preferences > General
UNIX is the most restrictive definition.

CtrlAltIsAltGr

Off / On

Support the AltGr key on none-english keyboards. See
Note 5 on page 44.

DefaultRulerCm

1.0cm

DefaultRulerInch

0.125in

Values for the tick marks on the vertical and horizontal
rulers in new documents. See Note 4 on page 44.

DefaultSnapCm

0.5cm

DefaultSnapInch

0.125in

DefaultvVectorFormatForXMLExport

MIF / CGM

Internal storage of Equations and Anchored Frames for
round trip XML

DictionaryProviderMismatchDialog

On / Off

Preferences > Spelling
Report on open: document dictionary provider different
to what is set for this language

DirectOLESupportInXml

Off / On

Switch OLE support in structured mode ON for PowerPoint and Visio. See Note 24 on page 47

DisableAutofitAfterZoom

Off / On

See Note 15 on page 46.

DisplayFileLeafFirst

Off / On

Displays the file name in the title of the document or
book window before the path name. See Note 17 on
page 46.

DisplayUsingPrinterMetrics

Off / On

OFF: correct character widths
ON: correct placement of characters on lines (default
since FM-8) See Note 10 on page 45

DontShowWelcomeScreen

Off / On

DoNotExportInvalidXML

Off / On

Controls being able to save an invalid xml file.

EnableAutoSpellCheck

On / Off

Spelling is checked on the fly

EnablePerformanceChanges

Off / On

???

EnableUndoInFDK

Off / On

???
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Variable

Default / Option

Remarks

EPSLevelForPlacedPDF

1/2/3

By default, FrameMaker prints imported PDF (Placed PDF)
files by converting them to Level 1 EPS files (with limited
colour support). Level 3 includes TTF rendering.

ErrorFileName

consfile.txt

This file is created anew at each start of FM. In case of
crash errors may be reported here. Hence save the file
for later use.

ExecutablePlugins

EXE

???

FMImage

Off / On

Controls whether a FrameImage facet is saved with imported graphics by default

ForceFileTypeChoices

Off / On

Force to bring up unknown file type dialog

FrameMakerPDFAssistant

Acrobat Distiller

Present in FM-6, but commented out; from FM-7.0 on
present in the APIClients section, but also commented
out

GDIRasterizeKiloPixelLimit

8192

Do not change this value!
Heck, then it should not be here in maker.ini!

GetLibraryColorRGBFromCMYK

Printing
Printing&Screen
Screen
none

See Note 21 on page 47
See also Adobe forums and Adobe blog

Gravity

Off / On

Magnetic snap for approaching objects

GreekSize

5

Below this font size just a grey bar is displayed for text

HidePanelsOnClose

Off / On

Preferences > Interface

HideSingleTabsInDocs

On / Off

Preferences > Interface

InputMethodAutoActivation

On / Off

For typing Asian text with special device. SeeNote 6 on
page 44

LastActiveView

WYSIWYG View / Author View Depending on the value an additional configuration file
/ Code View
comes into play: Authorview.ini on page 48 or XmlCodeView.ini on page 48

LastUsedWorkSpaceInStructuredMode

Structured Authoring

See Adobe blog

LastUsedWorkSpaceInUnStructuredMode

Authoring

See Adobe blog

LocDisplayCriteria

On / Off

Preferences > Panels and Pods location
criteria

-

Element1 / any element
Element2 / any element
Heading1 / any ¶
Heading2 / any ¶

LocElemType1
LocElemType2
LocParaStyle1
LocParaStyle2

MenuSet

Complete / Quick / Custom Quick menus are a subset of complete menus

MissingGraphicsDialog

On / Off

Missing in the Preferences > Alerts

MonitorSize

Default / 14 … 22 inch

Preferences > General
Diagonal size of the monitor to adjust display of 100%
zoom to actual size of objects

MultiMediaLinkTableRowLimit

100

Number of entries in the hotspot table

NetLibTimeout

20

??? [seconds]

NetworkLock

On / Off

Preferences > General
Causes FrameMaker to create a lock file (.lck) when you
open a file. The lock file deters others from opening the
same file and changing its contents while you have it
open. They can, however, open a view-only copy of the
file.

No3DInPDF

Off / On

Allow (Off) or disallow (On) 3D in PDF

NoFlashInPDF

Off / On

Allow (Off) or disallow (On) Flash in PDF
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Variable

Default / Option

Remarks

OpenCompDocsAsTabs

On / Off

Preferences > Interface: Open composite documents ...

OpeningOldReleaseDocDialog

On / Off

Report on open: document is of older version (Preferences > Alert Strings)

PenWidths

0.5, 1.0, 3.0, 4.0

Pen widths [pt] for graphic lines (valid: .015 … 360 pt).
Unit may be added:
0.1mm, 0.2mm, 0.35mm, 0.5mm

PostXSLTValidationOnExport

Off / On

When enabled, validates a file when saved as XML

RememberMissingFontName

On / Off

Preferences > General
Determines whether the names of unavailable fonts are
preserved so that the original fonts can reappear when
the file is reopened on a computer where they are installed.

RemoveExtraWhiteSpacesOnXMLImport

On / Off

ON: Remove spaces (for example) after inline images
OF: keeps spaces on xml import in place

RepeatEnabled

On / Off

??? Repeat last action in history

ReplaceCacheSize

200

???

RomanRanges

0000-024F, 0400-052F,
0370-03FF, 2000-206F

Definition within Unicode

ShowErrors

On / Off

Log / stop logging errors in the file ErrorFileName (for
OFF the console window is not displayed)

ShowLearningResourcesOnStarterPage

On / Off

Display a browser window with information related to FM
below the Welcome screen (Preferences > General)

Snap

On / Off

Graphics > Snap
new or moved graphics are aligned to the snap grid

SplashScreen

On / Off

Banner (splash) screen at start up appears. Starting with
FM-9 this is a Flash file

SuppressExtensions

fm, book

Suppress these extensions if suppressed in the Windows
shell. Leave value empty to disable suppression.

SuppressXMLParserWarnings

Off / On

Suppresses parser messages for duplicate elements
specified in a DTD. FrameMaker® uses the first instances

SymbolSortingBeforeAlphaNumeric

Off / On

OFF: sorting is l1-para, lb2-bulleted-2nd, lbtbulleted-tight, lb-bulleted
ON: sorting is l1-para, lb-bulleted, lb2bulleted-2nd, lbt-bulleted-tight (standard until FM-8)

TabbarStatus

On / Off

UIBrightness

3/1…3

UnavailableFontsDialog

On / Off

Preferences > Alert Strings
Report on open: document uses unavailable fonts

UnresolvedCrossReferencesDialog

On / Off

Preferences > Alert String
Report on open: Document contains unresolved cross
references.

UnsupportedHotspotShapesDialog

On / Off

???

UploadOnSave

On / Off

Upload to CMS on save of document

UseDisplayUnitInTemplate

Off / On

ON: default display units are taken from document templates. Otherwise
OFF: the values are taken from maker.ini. See Note 14 on
page 45.

UseGrayScaleAppIcon

Off / On

“The most reasonable feature of this application”
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Variable

Default / Option

Remarks

UsePostscript

On / Off

ON: FM uses built-in methods of generating PostScript
code, is faster and of higher quality.
OFF: use standard Windows methods. makes FM print the
preview image of EPS graphics instead of the PostScript
image.

UseSystemCursor

Off / On

OFF: Cursor images taken from FM
ON: Most cursor images taken from OS

Zoom

25, 50, 80, 100, 120, 140,
150, 160, 200, 400

Zoom factor settings (25 … 16000 are valid). A setting
of 353 provides 0.1mm per pixel

Variable

Default / Option

Remarks

AlwaysOnTopPaletteDir

fminit\plugins\toolbox\pal- See Note 7 on page 45
ette

Clipart

clipart

FM files with clip art made with FM-graphic tools

ColorLib

fminit\Color

Color library files. These files are read in at start-up and
appear in the Colour Libraries pop-up menu in the Colour Definitions dialogue box.

FontDir

fminit\fonts

[Directories]

FontDirCache

fminit\fonts\.cache

Folders to be scanned for variable-width font information for Japanese fonts. Do not change these settings.

HelpDir

help

Files for the local Help system; See Note 19 on page 46.

IndexSortDir

fminit\indexsort

Files for Asian index sorting

OnlineManuals

Documents

In FM-11 only a subdirectory containing files with SGML
errors exists.

OpenDirOnStart

-

Specifies which folder should initially appear in the
Open dialog box. On exit this setting is updated to the
folder from which you last opened a document.

PaletteDir

fminit\maker

See Note 7 on page 45

PaletteDirStructure

See Note 7 on page 45

Samples

samples

Document samples

TemplateDir

template

Standard templates that come with the product, except
the ones for custom documents and text files.

Templates

templates

???

UnicodeDir

fminit\unicode

Unicode files that are used to support Asian text in Acrobat bookmarks and other Acrobat features

Variable

Default / Option

Remarks

AlternateResources

fminit\fmcustom.dll

Define dialogue boxes, menus, error messages, and
other resources. See Note 8 on page 45.

ConfigCommandsFile

fminit\configui\cmds.cfg

Commands common to all platforms.

ConfigCustomUIFile

fmminit\configui\CustomUI.cfg

Menu and command customisation. See Note 9 on
page 45.

ConfigMathFile

fminit\configui\mathcmds.cfg

Math commands (for the Equation Editor)

ConfigMenuFile

fminit\workspaces\unstruc- Standard menus for the FrameMaker interface
tured\menus\menus.cfg

ConfigMenuFileStructure

fminit\workspaces\structured\menus\menus.cfg

Standard menus for the Structured FrameMaker interface

ConfigurationFilePath

-

???

[Files]
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Variable

Default / Option

Remarks

CustomDoc

fminit\custom

Template for new custom documents. Defines the minimal format catalogues.

DialogResources

fminit\fmdlg.dll

Define dialogue boxes, menus, error messages, and
other resources. Note 08

EPSHeader

fminit\header.ps

PostScript header file. Do not change this setting

EquationDoc

fminit\equation

Equations palette

FirstRunOpenDoc

-

Document to be opened at first run after installation.
Entry is cleared after that.

FMFont

fminit\fm5font.ttf

Special text symbols like ¶, 7, 6, 1, 2

FMSmallFont

fminit\fmsmall.fon

Font used in the Tools palette. Do not change this setting

InsetFilePathForMissingPoster

MissingPoster.bmp

Default poster image for multimedia insets

MarshallingDLL

afmfdk.dll

???

MathCharacterFile

fminit\mathchar.cfg

Defining the mathematical symbols

MSWinConfigCommandsFile

minit\configui\wincmds.cfg Windows specific commands

PageSizesFile

fminit\pagesize.cfg

Defines the page sizes for the seven standard page sizes listed in the Page Sizes popup menu in the
Custom Blank Paper. For a new custom document,
it also defines the default unit, column gap, and margin
settings for each paper size.

Resources

fminit\fmres.dll

Define dialog boxes, menus, error messages, and other
resources. Note 8 on page 45

RunWrappedPlugin

fmrnclnt.exe

???

SiteDictionary

dict\site.dct

Site wide dictionary. See Note 2 on page 44.

StructTemplateBrowserDoc

fminit\maker\tmpltbrw_s

Template browser for structured document, This is a FM
palette

TemplateBrowserDoc

fminit\maker\tmpltbrw

Template browser for unstructured document, ths is a
FM palette

ThesaurusDoc

fminit\thesaurs

Thesaurus dialogue box, This is an FM template

ToolBarXMLFile

fminit\toolbars\fmtoolbar.xml

List of available toolbars for the current workspace. See
Note 16 on page 46

TransformationFilePath

fminit\XSLT\DefaultTransformations.xml

Default global transformations. Custom transformations can be loaded from XML files. See menu XSLT >
Manage Transformations...

RecentlyVisitedFiles

This section is filled only in the user area. It gets a list of the
last 10 modified files which is displayed in the file history
File > Recent Files…
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Language services
[SpellingProvider
Preferences]

[HyphenationProvider
Preferences]

[ThesaurusProvider
Preferences]

[Spelling]

Variable

Value (example according to the settings in menu
Preferences)

Hunspell

US English, Deutsch, Schweizerdeutsch, Français, Español, Catalá, Italiano, Português, Português do Brasil,
Dansk, Norsk, Nynorsk, Svenska, Deutsch (neu),
Schweizerdeutsch (neu), Nederlands (nieuw),
Ελληνικά, русский, čeština, polski, magyar, Türkçe,
slovenčina, Slovenščina, български, Hrvatski, eesti,
latviešu, lietuvi, Română,

Proximity

UK English, Canadien Français, Nederlands, Suomi,

Variable

Value (example according to the settings in menu
Preferences)

Hunspell

US English, Deutsch, Schweizerdeutsch, Français, Canadien Français, Español, Catalá, Italiano, Português,
Português do Brasil, Dansk, Nederlands, Norsk,
Nynorsk, Suomi, Svenska, Deutsch (neu), Schweizerdeutsch (neu), Nederlands (nieuw), Ελληνικά, русский,
čeština, polski, magyar, Türkçe, slovenčina,
Slovenščina, български, Hrvatski, eesti, latviešu, lietuvi, Română

Proximity

UK English

Variable

Value (example according to the settings in menu
Preferences)

Hunspell

None

Proximity

US English, UK English, Schweizerdeutsch, Français, Canadien
Français, Español, Italiano, Dansk, Norsk, Svenska, Deutsch
(neu), Schweizerdeutsch (neu), Nederlands (nieuw),

All of these settings are the defaults for the spell checking
dialogue, which changes the settings in maker.ini

Variable

Default / Option

new

obs.

FindRepeatedWords

On / Off

FindUnusualHyphenation

Off / On

FindUnusualCap

Off / On

IgnoreSingleCharWords

On / Off

IgnoreAllCaps

On / Off

FindStraightQuotes

On / Off

FindExtraSpaces

On / Off

IgnoreRomanNumerals

Off / On

IgnoreWordsWithDigits

On / Off
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Variable

Default / Option

Remarks

FindTwoInARow

On !,.:;?

IgnoreWordsContaining

On . .

FindSpaceBefore

On
!%),.:;?]}\xC8\xD3\xD5\xDD List of symbols. Watch the blank after On/Off

FindSpaceAfter

On
$([{\xC7\xD2\xD4\xDC\xE2
\xE3

SmartQuotes

\xd4\xd5\xd2\xd3

Left single, right single, left double, right double quote.
SeeNote 3 on page 44.

Content management
[CMSFavourites]

This is initially empty and most likely gets filled at the use of
a CMS.

[DctmPreferences]

Preferences for Documentum®

[SpPreferences]

Variable

Default / Option

DctmOverwriteObjectAsVersion

Off / On

DctmOverwriteObjectOnUpload

On / Off

DfsSdkPath

-

ShowHiddenObjects

Off / On

ShowPrivateCabinets

Off / On

Preferences for SharePoint®
Variable

Default / Option

SpOverwriteObjectAsVersion
SpOverwriteObjectOnUpload

On / Off

Miscellaneous
[DialogLayout]

This section defines top and left position (pixels) of dialogues
and windows. These values are set by the program.

D

If for some reason a window or dialogue is no more visible, it
is useful to delete the appropriate entry (or all entries) in the
user area prior to a new start of FM.

[ViewClients[

[XSLTProcessors]

This should be modified only on request of Adobe Support.
Variable

Definition

Author View

internal, structured, author view, null, PL_SwitchToAV

WYSIWYG View

internal, all, wysiwyg view, null, PL_SwitchToWYSIWYG

XML View

plugin, structured, xml view, FMXmlView.dll, PL_SwitchToXmlView

Definition syntax: jar path, TransformerFactory class [, default]
 all dependent jars should be in same directory
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 if default is not specified - 1 st processor becomes default.

[APIClients]

Variable

Definition

SAXON

fminit\XSLT\XSLTProcessors\saxon\saxonhe9-3-0-5j\saxon9he.jar, net.sf.saxon.TransformerFactoryImpl, Default

XALAN

fminit\XSLT\XSLTProcessors\xalan\xalan-j_2_7_1-bin\xalan.jar, org.apache.xalan.processor.TransformerFactoryImpl

This long list may be amended by the installation of plug ins.
Normally this section is not present in the user area. It may
be useful to move entries concerning plug ins into the user
area or greater flexibility.

Definition syntax normal
Definition syntax for filter

ClientType, description, path, mode
ClientType, [facet, format_id, vendor_id, ] description, path,
mode, file extension
In the following example, FrameScript is activated for the
unstructured interface, but inactive (commented out) for the
structured interface.

fsl=TakeControl,FrameScript,H:\Adobe\FM-addons\Fscript_5_100\fsl5_100.dll,all
; FslStruct=Standard,FrameScript Struct Import/Export, … ,structured

See also Note 20 on page 47.

[DashPatterns]

Only 8 patterns may be defined. Their names may use any
character (except comma).
The pattern starts with dash-length, followed gap-length etc.
The length units is 1pt and depends for large line thickness
also on the pattern.
If a dash pattern setting contains an odd number of segment
lengths, the last dash value is repeated for the final gap.

Variable

Standard defintion

Example variant

1

Dash, 8, 6

Dash, 8, 4

2

Hidden, 4

Short Dash, 4

3

Longdash, 16, 10

Long Dash, 16, 8

4

Dot, 2, 4

Dots, 2, 3

5

Dash-Dot, 12, 6, 2, 6

Dash Dot, 12, 4, 2, 4

6

Dash-Dot-Dot, 12, 6, 2, 6, 2, 6

Dash+Dot&Dot, 12, 4, 2, 4, 2, 4

7

Chain, 12, 6, 6, 6

Chain, 12, 4, 4, 4

8

Phantom, 20, 6, 6, 6, 6, 6

Jump, 20, 4, 4, 4, 4, 4

[Thermometers]

This defines colours for progress bars, such as while printing
or creating PDF

Variable

Default / Option

Remarks

ThermoDoneColor

255, 0, 255

magenta

ThermoRemainingColor

192, 192, 192

light gray

[DocCompare]

Set up for the Document Compare Utility

Variable

Default / Option

Remarks

AddChangeBars

On / Off

Change bars are added to the composite document

CompareAttributesForElements

On / Off

For structured documents only

18 – 38

D

E:\_DDDprojects\FM-toolbar00\AllETB\etb-customising-fm.fm

2016-02-06

Initialisation file maker.ini

Variable

Default / Option

Remarks

CreateSummaryOnly

Off / On

OFF: Create summary and composite document
ON: Create a summary document only

DeleteConditionTag

Deleted

Condition tag to be defined for
MarkDeletedText = ConditionTag

DeleteReplacementText

^

Replacement text to be defined for
MarkDeletedText = ReplacementText

InsertConditionTag

Inserted

Condition tag to be defined for
MarkInsertedText = ConditionTag

InsertHyperTextLinks

On / Off

Hypertext links are added to the summary document

MarkDeletedText

ConditionDeleted / ConditionTag / ReplacementText

Standard delete condition / custom condition / with replacement text

MarkInsertedText

ConditionInserted / ConditionTag / Nothing

Standard inserted condition / custom condition / -

ThresholdFactor

75

Controls when to mark an entire paragraph or table cell
as changed. 75: an entire paragraph is marked as
changed if 75% or more of the words are changed.

Structure view
[StructureView]

This section defines the appearance of the structure view.

Variable

Default / Option

Remarks

AlwaysStayOnTop

On

Structure view window

AttrFont

Arial

AttrValFont

Arial

AttrSize

10

AttrValSize

10

AttrValidate

On / Off

AttrAllSym

-

AttrErrSym

x

AttrSepSym

=

AttrNoneSym

+

AttrSomeSym

+

CollapseSym

-

ExpandSym

+

Position

360, 144, 376, 272

ElemFont

Arial

ElemFontJapanese

MS Gothic

ElemFontKorean

Dotum

ElemFontSimplifiedChinese

SimHei

ElemFontTraditionalChinese

MingLiU

ElemSize

10

KeywordFont

Arial

KeywordSize

10

SnipFont

Arial

SnipPos

4, 8, 12, 16, 20, 24

SnipSize

10
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Variable

Default / Option

TagFont

Arial

TagSize

10

Origin

24, 24

[BannerText]

Remarks

???

Banner text in a FrameMaker file instructs you about what to
enter in an element. Banner text is controlled using the
BannerText element in the EDD.
Variable

Default / Option

BannerTextBKColor

GrayVeryLight

BannerTextFontAngle

Italic

BannerTextFontFamily

Times variant

BannerTextFontVariation

Regular

BannerTextFontWeight

Bold

RedisplayBannerTextForEmptyElements On / Off

a

a. Determines whether the banner text gets redisplayed after it is deleted once.
ON: banner text always shows up for empty elements.
OFF: banner text doesn't show up after deleting it or reopening the file
after saving it.

Fonts
[Fonts]
Variable

Default / Option

Remarks

Angles

Regular, Kursiv, Slanted,
Oblique, Italic, Obliqued

Definition of the font vocabulary: a list of the words.

AtmFontAutoActivation

On / Off

See Note 11 on page 45.

AtmFontSubstitution

Off / On

SeeNote 12 on page 45.

DefaultFamily

Times, Times New Roman,
Tms Rmn

DefaultAngle

Regular

DefaultVariation

Regular

DefaultWeight

Regular

DefaultSize

12

DefaultJapaneseDialogFont

ＭＳ Ｐ ゴシック , 9

For dialogues on Asian systems with nonacid resources

DefaultJapaneseFamily

Japanese font in JIS X 0212-1990 Shift-JIS

DefaultKoreanDialogFont

ＭＳ 明朝 ,MS Mincho
System, 10

DefaultKoreanFamily

?? ,Batang

Korean font in KS C 5601-1987

DefaultSimplifiedChineseDialogFont

System, 10

For dialogues on Asian systems with none-Asian resources

DefaultSimplifiedChineseFamily

Simplified Chinese font in GB 2312-80

DefaultTraditionalChineseDialogFont

宋体 ,SimSun
System, 10

DefaultTraditionalChineseFamily

細明體 ,MingLiU

Traditional Chinese font in Big5

MathFamily

Symbol

Font family used for FrameMath (Equation Editor)
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Variable

Default / Option

Remarks

NonTextFamilies

ZapfDingbats, Symbol,
Font families that will not be spell checked
WingDings, Monotype Sorts,
Euro Monospace, Euro Sans,
Euro Serif

Sizes

7pt, 8pt, 9pt, 10pt, 11pt,
Sizes which will appear in the Format dialog boxes (val12pt, 14pt, 18pt, 24pt, 36pt ues must be 2pt … 400pt). The list may be extended

Variations

UltraCompressed, ExtraCompressed, Compressed,
Condensed, Narrow, Regular, Wide, Poster, Expanded

Weights

Thin 100, ExtraLight 200,
Definition of the font vocabulary: list of words and the
SemiLight 250, Light 300,
associated weight for Windows, if the font comes from
Book 300, Regular 400, Sem- another platform.
iBold 600, DemiBold 600,
Bold 700, ExtraBold 800,
Heavy 900, Bolded 700

UiCalcFont

MS Sans Serif, 8, 600

Definition of the font vocabulary: a list of the words.

Font information used for UI calculations (size of popup menus)

A font in Windows does not always have the same name as
the comparable font on another platform. This often happens
because in Windows a variation such as Narrow is part of a
font family, whereas on other platforms the variation is an
option independent of the font family. Moreover, Windows
uses only regular and italic for angles, while some fonts on
other platforms have additional angles such as oblique.

[FontAngleAliases]
Variable

Defautl / Option

Remarks

Obliqued

Oblique

Angle aliases used when reading documents from other
platforms (basically synonyms used when reading a document). See Note 13 on page 45.

Variable

Default / Option

Remarks

Bolded

Bold

Demi

DemiBold

Medium

Regular

[FontWeightAliases]

Roman

Regular

Semi

SemiBold

[WindowsToFrame
FontAliases]

Weight aliases used when reading documents from other platforms (basically synonyms used when reading a
document). See Note 13 on page 45.

Each setting under [WindowsToFrameFontAliases] assigns a
Windows font to a FrameMaker font name. Thus, font information appears in the Windows interface as it does in other
versions of FrameMaker. For example, Helvetica Narrow is
normally a font family in Windows, but with aliasing Helvetica
appears as a font family and Narrow appears as a variation in
the Character Designer and Paragraph Designer.
Font aliasing also makes it possible to go back and forth easily between Windows and other platforms. FrameMaker automatically converts Windows fonts to their FrameMaker
equivalents for you.
The settings use this syntax (it must be on one line):
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Windows-font [angle|*], [weight|*]=Frame-font [angle|*], [weight|*], [variation|*]

Windows-font

This is a font family available in Windows. The angle for this
font can be either Regular or Italic, and the weight can be
one of the weights defined in the font profile under [Fonts].
You can also use an asterisk (*) to specify no particular angle
or weight.

Frame-font

This is a font family available on the other platforms. The
angle, weight, and variation for this family can be any of the
ones defined in the font profile. If you use an asterisk (*), the
FrameMaker font will use the angle, weight, or variation from
the Windows font.

Example

HelveticaNarrow, * , * = Helvetica, * , * , Narrow

This setting assigns the Windows font family Helvetica
Narrow to the FrameMaker font name Helvetica with the
Narrow variation: The two asterisks specify that angles and
weights are not affected in this alias.
If you do not have an appropriate alias defined for a Windows
font, the default alias is used:
Windows-font *, *=Frame-font *, *, *

You can find more examples at Common Font Aliases for
FrameMaker for Windows and Cross-platform font usage in
FrameMaker

[UnknownToKnown
FontMap]

When you open a document that requires fonts not available
on your system, an alert box appears telling you the document uses unavailable fonts. If you click OK, FrameMaker
opens the document and substitutes the unavailable fonts
with the fonts specified under [UnknownToKnownFontMap]e. Initially, this section has some mappings for common situations,
such as fonts from none-Windows platforms.
Note:

The settings under [UnknownToKnownFontMap] map one
FrameMaker font to another. This is different from
[WindowsToFrameFontAliases], which assigns a FrameMaker
font name to an equivalent Windows font.
The mappings must use this syntax (it must be on one line):

unavailable_Frame_font [angle|*], [weight|*], [variation|*]
= available_Frame_font [angle|*], [weight|*], [variation|*]

The angles, weights, and variations for these mappings can be
any of the ones defined in the font profile under [Fonts]. You
can also use an asterisk (*) to specify no particular angle,
weight, or variation.
Example

Lumina, *, * = Helvetica, *, *, *
Helvetica, *, Light, * = Helvetica, *, Regular, *
Helvetica,*,*, UltraCompressed = Helvetica,*,*,Narrow

If you open a document with unavailable fonts and don’t have
substitutes mapped for those fonts, FrameMaker replaces
them with the default fonts defined under [Fonts] instead
(typically a Times variant).
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[Filters]

17)

This section contains settings for identifying foreign file
formats, export filters, and import filters. FrameMaker provides these settings when you install filters. If you want to
change any of the settings, install the filters again. Do not
edit the settings manually in an initialisation file.
Syntax definition changed over the development of FM:
FM-3

n=<source-name> <destination-name> <type> <via> <file-extension>

FM-4

n=<UI-name> <clipboard-name> <type> <via: executable in-fmt out-fmt
...>

FM-5 …

n=<formatid><vendorid><source-name> <destination-name> <type>
<description> <via> <file-extension>

<vendorid> and <filterid> are 4-byte strings (if shorter,
blank-pad on the right and enclose in straight quotes.
Example definitions
1

"CDR " IMAG CDR FrameVector GFXImport "Corel Draw" IMAGMARK.DLL ^.cdr

3

"DIB " FRAM DIB DIB FMGFXImport "DIB" Frame.exe ^.bmp

307 "0602" AW4W MIF WordPerfect ExportFilter "WordPerfect Mac 3.5" aw4w.xxx
^.wp

See also Note 20 on page 47.
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The concatenation <vendorid><filterid> is used by FM to
identify filters uniquely.

17 As far as I know the new installation routines do not allow to specify subsets of filters to be installed. IMHO since FM-9 all filters are installed.
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Notes to the maker.ini entries
Note 1

With the development of Windows the clipboard formats and
their order changed:
FM-3

OLE, META, DIB, BMP, TIFF, FrameTable, RTF, TEXT

FM-4

OLE, META, DIB, BMP, MIF, RTF, TEXT

FM-5 … FM-7

FILE, OLE 2, EMF, META, DIB, BMP, MIF, RTF, TEXT

FM-8 … FM-9

FILE, OLE 2, EMF, META, DIB, BMP, MIFW, MIF, RTF, UNICODE TEXT,
TEXT

FM-10

FILE, MIFW, MIF, RTF, OLE 2, META, EMF, DIB, BMP, UNICODE TEXT,
TEXT

Most time you want plain text with no formatting. For this
change the order in this list to:
UNICODE TEXT, TEXT, RTF, MIF, MIFW, EMF, META, DIB, BMP,
FILE, OLE 2

Note 2

With FM-9 the dictionaries became shared with other Adobe
Applications and are now in Userarea\Adobe\Linguistics\Dictionaries. The mechanism to
integrate user dictionaries is not that clear despite the Adobe
blog entry.

Note 3

The following quotation marks are defined for the languages
given. Only one may be active (not commented out):
;English
'
'
"
"
SmartQuotes=\xd4\xd5\xd2\xd3
;German
‚
'
"
"
; SmartQuotes=\xe2\xd4\xe3\xd2
;French
‹
›
«
»
; SmartQuotes=\xdc\xdd\xc7\xc8
;Swedish/Finn. '
'
"
"
; SmartQuotes=\xd5\xd5\xd3\xd3
;Italian
'
'
"
"
; SmartQuotes=\xd4\xd5\xd2\xd3

Note 4

There are a pair of settings for each of these items so that
both inches and centimetres can be specified. The values that
FrameMaker uses depend on the measurement system specified in the Number tab of the Regional Settings Control Panel
in Windows. The unit of measure (in, cm) must be noted at the
value.

Note 5

When using a Language specific keyboard (Windows platform), the Right Alt-key (AltGr) triggers specific accented
characters in the selected input language. The CtrlAltIsAltGr
setting simply adds this facility to using the ctrl + alt keys
together. This is useful in the case of no right-alt key being
available on say a notebook keyboard. Without the ON setting
some shortcuts CTRL+ALT+x do not work properly.

Note 6

Typing text in Asian fonts is accomplished via a special input
device. FrameMaker can recognize when you are typing an
Asian font and invoke this device automatically. By default,
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this is set to On. If you set this to Off, you must use the
appropriate command to invoke the input device.

Note 7

PaletteDir, PaletteDirStructure, and AlwaysOnTopPaletteDir
specify palette folders. The values for these settings are a list
of folder names, separated by commas. When you store a document in one of these folders, FrameMaker treats it as a palette (such as the Tools palette or Equations palette). Palettes
in AlwaysOnTopPaletteDir always float in front of documents.

Note 8

See for example Toolbar resources for FM ≤ 8 and Toolbar
resources in FrameMaker 10.

Note 9

ConfigCustomUIFile specifies the file that contains additional
custom menus or changes to existing menus or commands
that you have added. The default file for this setting is customui.cfg. You can either add your menu customisations to this
file, or create your own file and put its path and file name in
this setting.

Note 10

FrameMaker always uses printer font metrics to calculate
where line breaks and page breaks occur. However, by default
(before FM_8), the relative position of each character within a
line is displayed on the screen using screen font metrics. This
looks better on the screen but is misleading in that the positions of characters within a line on a printed page may be different than on a displayed page. In particular, if you are
trying to position a graphic relative to a character in a line,
you should change this setting to ON which results in the use
of printer font metrics when displaying lines.

Note 11

AtmFontAutoActivation determines whether font sets in Adobe
Type Manager Deluxe 4.x will be automatically activated. This
means that if you open a document that uses a font that is
installed on your computer but is not in a font set that's currently active, the font set will be activated automatically. The
otherwise inactive font is displayed and prints correctly, but
it does not appear in font menus.

Note 12

AtmFontSubstitution determines whether ATM Deluxe will create a stand-in font for one that is missing by simulating the
shape and spacing of the missing font. The simulated font
will not be an exact match but will preserve line breaks and
the general look of the de-installed font. Font substitution
may delay displaying a document on slower computers or if
there are many fonts that must be substituted.

Note 13

Windows fonts use different font angles and weights, even
when font names are the same as on other platforms. The settings under [FontAngleAliases] and [FontWeightAliases]
assign angles and weights used on other platforms to Windows angles and weights.

Note 14

With UseDisplayUnitInTemplate to On, the default display
units for the ruler, grid, and snap are taken from the document. When set to Off, the values are taken from what in the
ini file itself. This makes a difference because you may want
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your template users to be always working in points, but
unless you set this to On, no amount of tweaking the template
to only use points will assure that the users will only see
points.

Note 15

I said wouldn't it be great if FrameMaker could automatically
show you just the text frame. The engineers agreed, and the
Fit Window to Text Frame option in the zoom pop-up menu
was born. But this feature had a side-effect:. After you've chosen Fit Page in Window or Fit Window to Page from the Zoom
pop-up menu, the window size changes when you change the
zoom level. So what? Well, it turns out that a lot of people like
to click the little z or the big Z several times in a row to zoom
incrementally. And they couldn't do that anymore because the
z's moved around when the window resized. Hence, the
DisableAutofitAfterZoom option was born. [Source]

Note 16

See details at blogs.adobe.com. The file fmcustom.dll got
many new icons. An additional resource file (owlres.dll) is
not mentioned in maker.ini.

Note 17

If the value is On, the file name in the document or book window title is shown in the format filename pathname. This format is also used to display the file name in the dialogue that
lists all open files. By default the value is set to Off, the line is
marked as a comment, and the file name is displayed in the
format pathname filename, as previously.

Note 18

When you import an image, it is stored as a temporary file on
the local computer. If you import the same file again, the file
is not downloaded. If you modify the file after importing it
into FrameMaker, the modifications will not take effect until
you delete the temporary file and import the graphic again
into the FrameMaker document, or set the value of the
AlwaysDownloadURL flag to On. However, if you copy the
FrameMaker document containing the imported graphic to
another computer, the file is downloaded again when you
import it by specifying the HTTP file path.
When you import a graphic into a structured document by
specifying an HTTP path, the graphic is downloaded each time
you import the graphic. The HTTP path of the graphic is
retained when the document is saved as an XML document.

Note 19

Help formats changed during the development of FM:
FM-3

Unknown

FM-4

FM-4 view only file with help.api (about 65 files)

FM-5

FM-5 view only file (about 50 files)

FM-6

Windows Help file (1 file)

FM-7

HTML-help (about 1250 html files)

FM-8

Windows compiled HTML help (1 chm file)

FM-9 …

No local help file any more. Help > Help Topics… invokes a link
to Adobe Online Help. A pdf can be downloaded from there.
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Note 20

Number of APIs and Filters have significantly changed over
time:

Number of…

FM-3

API's
Filters

FM 5.5 FM-6

FM-7

FM-8

FM-9

FM-10 FM-11

2

6

10

9

44

55

45

69

82

71

39

27

78

78

78

47

48

70

73

378

448

501

638

660

~ 745

805

842

911

963

3.8

4.6

7.6

9.6

9.3

9.7

96.5 220…30
0

769

612

638

746

2.9
18.8

Size of installation directory [MB] en

Note 21

FM-5

0

Size of maker.exe [MB]

Most library colours contain a CMYK value and an RGB value.
The CMYK value is used for printing and the RGB value is
used for screen display. The 4 options are:
Printing&Screen This is the FrameMaker 5.x behaviour. It will
display and print the converted RGB value.
None

This is the FrameMaker 5.5 behaviour. It will display and print the RGB value produced by the colour library.

Printing This is the default in FrameMaker since version
5.5.6. It will display the RGB value produced by the
colour library and print the converted RGB.
Screen

This displays the converted RGB and prints the
RGB values from the library.

Note 22

With FM-11 Views were introduced which moved this enty
into AuthorView.ini (section General) and/or XmlCodeView.ini
(section General).

Note 23

When FrameMaker was first developed, placed graphics
needed a screen representation within the document to facilitate placement. However, if your choice of imported formats
(like AI and PDF files) doesn't require generating those images
then you can trim the size of your files by turning off the flag
for producing facets for placed images. You now have the
choice of removing graphic facets from imported files, which
has the net effect of reducing your FrameMaker file size.

Note 24

If you wish to round trip to applications such as Visio files
and PowerPoint, you set the variable to ON. This lets you see
the direct reference to the file in the XML View, and doubleclicking on the placed image in FrameMaker will open up the
graphic in the appropriate application. If other applications
should be supported for OLE, add them to the [Filters] section of maker.ini according to these examples:
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Lines in maker.ini including. comments

FM-4

54="pptx" OLE2 OLE2 OLE2
55="VSD" OLE2 OLE2 OLE2

FMGFXImport "pptx" frame.exe ^.pptx
FMGFXImport "VSD" frame.exe ^.vsd
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Authorview.ini
Variable

Example definition

LastUsedWorkspace

Blank

XmlCodeView.ini
These entries define the syntax highlighting in Code View
with function Pretty Printing. The settings are available in
menu Preferences > XML.
Variable

Example definition

AttributeColor

255

AttributeValueColor

16711680

CDataColor

8421504

CommentColor

32768

DelimiterColor

16711680

ElementNameColor

128

EntityColor

255

FontFamily

Consolas

LastUsedWorkspace

Default

LineNumber

Yes

PIColor

16711935

WordWrap

No

XMLDeclarationColor

16711935
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